
	Bases de Datos


	MS ACCESS


	Objetivos

	Al terminar este tópico, usted será capaz de:

1. Explicar qué es una base de datos y


  nombrar sus componentes
	


INTRODUCCIÓN

	¿Qué es una Base Datos (o Banco de Datos)?


Nuestra vida cotidiana y laboral se encuentra constantemente bombardeada de información.  Debido a que es prácticamente imposible que los maestros puedan retener toda esta información en su memoria a largo plazo, es imperativo que desarrollen destrezas tocante a cómo buscar e interpretar la información requerida.  Consecuentemente, es imperante el uso de una herramienta que le permita a los maestros recoger, añadir, organizar y relacionar de manera dinámica un grupo de elementos informativos (Ej: datos sobre los estudiantes), es decir, una base de datos informatizada.
Un banco de datos está diseñado para almacenar datos y ponerlos a disposición del usuario de una forma sencilla y flexible.  Incluso, las bases de datos más pequeñas pueden contener miles de registros.  Estos registros (como, por ejemplo, los registros de los alumnos) pueden ser clasificados de acuerdo con cualquier orden, seleccionándolos (para acceder a ellos) bien individualmente o agrupados de la manera como el usuario desee, y pueden aparecer en pantalla o en papel con el formato de un informe (véase Figura 1.5).
Una base de datos representa una colección de archivos de datos interrelacionados, es decir, un conjunto de información relacionada sobre un tema, organizada de acuerdo a una estructura o propósito específico, de manera que provea una base para realizar ciertos procedimientos/operaciones particulares, tales como la búsqueda, ordenamiento, recuperación y recombinación de información, la elaboración de conclusiones y la toma de decisiones.  Una base de datos no electrónica puede ser un libro de direcciones, una caja de recetas, un archivo de gavetas, un archivo "Rolodex", entre otros.  La información se divide por lo general en distintos registros de datos, cada uno con uno o más campos de datos.

Un paquete de base de datos está diseñado para ayudar al usuario a crear sus propios archivos con miles de registros quizá, capturar la información, guardarla en un disquete, reordenarla, clasificarla de acuerdo a ciertos campos, seleccionar subconjuntos de registros y de campos dentro de los propios registros y elaborar informes.  Una base de datos puede manejar cualquier dato en forma de caracteres, bien sea texto o números.  Hoy en día, muchas escuelas guardan registros de sus estudiantes en bases de datos

	¿Qué es un Programa de Administración de Base de Datos?


En aquellas circunstancias donde es necesario manejar una gran cantidad de información, es de vital importancia recurrir a un sistema para el manejo de los datos computadorizado, de manera que se pueda controlar el almacenaje y manejar los datos en un banco de datos.  Un programa de administración de base de datos es una aplicación que proporciona las herramientas para recuperación, modificación/editar, eliminación e inserción de datos en un archivo de base de datos.  Tales programas también son capaces de crear una base de datos y generar resultados significativos en la impresora o en la pantalla.  Estos programas que administran base de datos permiten al maestro llevar a cabo las siguientes operaciones/funciones:

(
Definir campos

(
Organizar los campos que constituyen el registro 

(
Entrar y modificar los datos en los registros

(
Ordenar la información en diversas maneras (Ej: alfabéticamente por el apellido).

(
Llevar a cabo búsquedas selectivas a través de la información (Ej: buscar todos los alumnos que viven en un pueblo particular).

(
Generar varios informes o resúmenes de la información y poder imprimirlos.

(
Almacenar/guardar la base de datos en un disco flexible.

Un programa de administración de base de datos le permite al maestro crear sus propios archivos con la cantidad que él desee de registros, realizar búsquedas (vía palabras claves) para poder capturar/recuperar la información, organizarla, manipularla y guardarla en una fuente de almacenamiento (Ej: disco flexible o disco duro), reordenarla, clasificarla de acuerdo a ciertos campos, seleccionar subconjuntos de registros y de campos dentro de los propios registros y elaborar informes. Una base de datos puede manejar cualquier dato en forma de caracteres, bien sea texto o números.

Existen tres tipos de programas de administración de bases de datos, a saber:  1) de archivos planos, 2) relacionados y 3) orientados a texto.  Las bases de datos de archivos planos se limitan a un solo archivo de dato a la vez, entre los cuales se encuentran "Microsoft Works" y "AppleWorks" (antes conocido como "ClarisWorks").  Las bases de datos relacionadas son más poderosas pero más complejas de manejar.  Le permiten al usuario interrelacionar información a través de más de un archivo de dato.  Algunos de los programas comercialmente disponibles bajo esta categoría son: Microsoft Access, dBASE, FileMaker Developer y MindModel.  Algunos sistemas de bases de datos relacionadas que son populares a nivel de las empresas incluyen: Microsoft SQL Server, OracleTM, SysbaseTM, DB2TM, InformixTM y MySQLTM.

	Datos Dinámicos


Uno de los principios esenciales de las bases de datos relacionales es que los datos nunca deben aparecer por duplicado.  Se crea un archivo con una información determinada, no copie ni vuelva a introducir los datos de los campos.  A lo sumo, bastara con un único campo duplicado en el que los dos conjuntos de información se “encontrarán”.  Este punto de encuentro se denomina campo de clave.  Es una categoría d información única en la que se identifican los registros de una base de datos que hacen referencia a un determinado registro de otra.  Puede utilizar este campo clave para mostrar los datos de otra tabla en una presentación junto a los datos de la primera tabla.

Un ejemplo clásico para ilustrar las bases de datos relacionales puede ser el registro de un grupo de estudiantes de una facultad.  Las facultades pueden tener miles de estudiantes y cientos de asignaturas, por las que resultaría inútil duplicar la información de cada estudiante en cada lista del curso.  En su lugar, la lista del curso se crea a partir de la base de datos de las asignaturas.  La lista del curso es el lugar en el que se encontrarán todas las bases de datos y el número de curso sería el campo en el que se realizarán las conexiones.
	Bases de Datos vs. Aplicaciones par Bases de Datos


A veces la gente no logra distinguir del todo entre las bases de datos y las aplicaciones de bases de datos.  Éste suele ser el caso de personas que aprenden practicando con Accecc en lugar de estudiar la teoría de las bases de datos.  Access reúne el desarrollo de bases de datos y el desarrollo de aplicaciones de base de datos, sin separarlos aparentemente.

Una base de datos es un recopilación de registros integrados que se describe a sí misma.  Se describe a sí misma porque la información que describe la estructura de la base de datos está incluida en la propia base de datos.  Los registros están integrados porque las relaciones entre los elementos de datos se mantienen explícitamente.  Estas dos características son las que distinguen una base de datos de una simple colección de elementos de datos.  Una base de datos es una recopilación estructurada de datos.  Por sí misma no resuelve problema alguno ni cumple ningún propósito.  La aplicación de base de datos utiliza los datos de la base de datos para resolver problemas o cumplir un propósito.

Por otro lado, una aplicación de base de datos es un programa que colabora con la base de datos para conservar y distribuir la información deseada.  La aplicación de base de datos puede estribarla un desarrollador de aplicaciones de base de datos o puede ser generada semiautomáticamente mediante un DBMS como lo es Access.  En una base de datos relacional, los datos se guardan en tablas, que dan a los datos su estructura.  Una aplicación de base de datos puede incluir formularios e informes que permitan a los usuarios interactuar con la base de datos con el objetivo de cumplir un propósito.

	Los Niveles de una Base de Datos


El término base de datos describe cualquier cosa, desde un libreta de direcciones, una caja de recetas, diccionario o un archivo de gabinete hasta un conjunto de archivos de datos con relaciones sofisticadas.  Para poder entender que es una base de datos, se requiere estar familiarizado con tres términos o niveles que posee un banco de datos, los cuales son: archivo (file), registro (record) y campo (field).
Archivo
Un archivo es una colección de información sobre un tópico particular.  Toda la información colectada en el tópico se encuentra localizada en el archivo.  Un archivo de datos ("datafile") representa una colección de registros comúnmente estructurados.  Por ejemplo, una  clase estudiando los pájaros de Puerto Rico, puede colocar toda la información sobre este tema en una carpeta rotulada pájaros.

Registro
La base de datos contiene registros (Ej: los registros de los estudiantes) que pueden ser clasificados en el orden deseado por el usuario.  Un registro contiene toda la información sobre una entrada en un archivo.  Un registro en un archivo de dirección puede contener toda la información sobre una persona en particular.  Un registro contiene la información sobre una entrada en el archivo.  El registro se relaciona directamente al propósito designado del archivo de la base de datos, es decir, representa toda la colección de campos.  Cada registro deberá poseer la misma colección de campos.  Por ejemplo, en una base de datos de los registros de los estudiantes, cada registro corresponde a un estudiante, el cual se compone de diversos campos de información que atañan a las característica particulares del alumno, tales como su nombre, número de estudiante o seguro social, edad, dirección, teléfono, e-mail, nombre de los padres, entre otros.

Siguiendo el ejemplo anterior, un registro sería la información sobre un ave en particular, tal como el pitirre.

Campo
Dentro de cada registro se encuentran los campos que organizan la información en el registro Dentro de un registro existen campos o espacios para información específica.  Una hoja de cálculo o electrónica (Eje: MS Excel) puede ser comparada con una calculadora, puesto que es capaz de realiza operaciones matemáticas y estadísticas.  La hoja electrónica almacena un reglón la información (datos) en una celda.  Por otro lado, una base de datos almacena un renglón de los datos en un lugar comúnmente conocido como campo.  Cada campo representa un renglón de información en una base de datos.  Un campo representa cada categoría individual de información.  Por ejemplo, los posibles campos creados para el pitirre pueden ser:  tipo de pico, nombre científico, hábitat y patrones de migración.  Un ejemplo de un registro de estudiantes puede estar constituido de los siguientes campos:

APELLIDOS: RODRÍGUEZ VELEZ

NOMBRE: JOSÉ

SEGURO SOCIAL: 567-0-96785

FECHA DE NACIMIENTO: 6/28/90

EDAD: 10

SEXO: M

COLOR DE OJOS: MARRÓN  

GRADO: 5

MAESTRA: JUANITA

NOMBRE DE PADRES: FRANCISCO Y MARÍA

DIRECCIÓN: CALLE 568 URB METRÓPOLI

TELÉFONO: 789-0755

EMAIL: JOSÉ78@HOTMAIL.COM

PROMEDIO GENERAL: 2.00
NECESIDADES PARTICULARES: DÉFICIT DE ATENCIÓN
	La Analogía de una Base de Datos en Una Oficina


La analogía de una base de datos en una oficina sería un archivo de gavetas o un archivo de tarjetas tipo "Rolodex" (véase Figura 1.1).  El objetivo de una base de datos es de poder almacenar información importante que sea fácil de recuperar cuando así se desee.  El archivo de gabinete, o base de datos, en la Figura 1.1 contiene archivos relacionados que almacenan información en una manera sistemática.
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	Figura 1-1: Cómo una Base de Datos Trabaja.  La analogía de una base de datos (Adaptado de: Computer Education for Teachers (2da. ed., p.91), por V. Sharp, 1996, Boston, McGraw Hill Companies.  Copyright 1996 por: The MacGraw-Hill Companies, Inc).
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	Figura 5-2: Campos.  Ejemplo de los campos de un registro (Adaptado de: Computer Education for Teachers (2da. ed., p.91), por V. Sharp, 1996, Boston, McGraw Hill Companies.  Copyright 1996 por: The MacGraw-Hill Companies, Inc).


	Microsoft Access


Microsoft Access (versión 1.0) fue presentado como un sistema de administración de base de datos  ( database management system, DBMS) para las computadoras PC en el 1992.  Un programa de este tipo viene acompañado con todas las utilidades de apoyo requeridas, herramientas de programación y la documentación necesaria para crear, instalar y dar mantenimiento a las aplicaciones de bases de datos personalizadas.  Microsoft Access, es pues, programa de administración de base de datos, en el que la información se guarda en tablas, cuyas columnas y filas se pueden relacionar si las tablas tienen una columna o campo común.  El término relacional se refiere l almacenamiento y recuperación de datos en tablas.  El componente de base de datos de Access se encuentra diseñado para que trabajar como un archivo de gavetas electrónico "inteligente".  En Access, una base de datos consiste de una colección de tablas, es decir, la información se guarda en tablas de datos bidimensionales.  Se define como relación las tablas que componen la base de datos. Las filas en las tablas se llaman registros.  Las columnas de las tablas se llaman campos. o atributos.  Un campo contiene una parte específica de información dentro de un registro.  Por ejemplo, un campo puede ser el Seguro Social de un estudiante.  Este campo posee un formato especial. Estos números son únicos, esto es, no existen dos estudiantes con los mismos números de seguro social.  Tal campo se utiliza como un identificador único (unique identifier).  Esto simplemente significa que dado un número de seguro social de un estudiante, éste habrá de aparecer únicamente en un registro sencillo en la tabla.  Un solo registro existe, por ejemplo, en el cual el número de seguro social del estudiante es 568-45-0976.  Un identificador único también se conoce como la clave primaria (primary key).  Por consiguiente, el campo del número de seguro social del estudiante representa la clave primaria (primary key) para la tabla del registro de los estudiantes.
Los programas computadorizados dirigidos a organizar/manejar bases de datos es de gran utilidad para los maestros.  Las posibles funciones se enumeran a continuación:
(
Crear y mantener información básica de los estudiantes en las clases.
(
Desarrollar archivos bibliográficos de libros y/o artículos disponibles en la escuela que apoyan al currículo.
(
Mantener registros de medios audiovisuales y materiales.
(
Construir una colección de pruebas o preguntas para exámenes cortos (Ej: quizes) ordenadas por tópico, capítulo del libro, objetivo, y posiblemente otros identificadores, tal como la taxonomía de Bloom.
(
Almacenar compilaciones de métodos de enseñanza, estrategias, y planes diarios.
El programa de Access representa un sistema para manejar bases de datos relacionadas basado en objetos.  Los objetos que componen una base de datos creada en Access son los siguientes:
Tabla (Tabla)

Es un objeto que representa los datos en filas y columnas, similar a la hoja electrónica.  Cuando el usuario observa la tabla en una base de datos de Access, éste se encuentra en lo que Access le llama como "Datasheet View".

Query (Consulta, Búsqueda)

Literalmente implica la acción de buscar y recoger datos.  En Access, representa un objeto que hace una solicitud a la base de datos para localizar/recuperar algún conjunto de datos almacenados en la base de datos.  Es, pues, una pregunta de búsqueda que le indica al programa el tipo de datos que debe recuperarse de la base de datos.  Permite al usuario que recupere únicamente la información que necesita para un propósito específico.  Una consulta específica las características (el criterio) empleadas para guiar a la computadora en la recuperación de la información requerida
Form (Forma)

Es un objeto el cual le ofrece al usuario otra manera de ver los datos en la base de datos. Exhibe los contenidos de solo un registro a la vez.

Macro
Representa una secuencia de instrucciones que pueden ser realizadas con un simple clic de ratón sobre un botón en una Barra de Herramientas o al presionar la tecla o teclas del teclado.  

Module (Módulo)

Es una colección de procedimientos de programación designado para darle al programador el control sobre como se verá y sentirá la base de datos de Access.
Una base de datos de Access puede estar constituida de una cantidad dada de registros; los registros contienen campos; cada campo contiene el dato bruto o crudo de los datos, llamado entradas, el cual se compone de caracteres que son las unidades fundamentales de los datos.  Por ejemplo, en un archivo de base de datos de los estudiantes, el maestro habrá de crear un registro de sus alumnos en una clase dada.  Cada registro incluirá nombres de campos (los nombres de campos de las base de datos de Access pueden poseer hasta un máximo de 63 caracteres), tales como APELLIDOS, NOMBRE, SEGUROS SOCIAL, entre otros).
Por consiguiente, una base de datos contiene registros; los registros tienen campos; los campos contienen entradas.  Estas entradas se pueden verse desde las funciones de la Tabla (Data View), Form, y Report (Informe) de la base de datos de MS Access.
Antes de comenzar a entrar registros en una base de datos, es muy importante que se identifique las metas de la base de datos y planificar la manera en que los datos serán almacenados.  La base de datos puede poseer más de una tabla; se debe decidir, entonces, la cantidad de tablas que habrá de constituir la base de datos y el tipo de datos ha ser almacenados en cada tabla.  La planificación para el desarrollo de una base de datos incluye los siguientes pasos:
(
Determinar el propósito de la base de datos y otorgarle un nombre significativo.
(
Determinar los resultados, conocido como "output", que el usuario desea ver, empleando la información almacenada en la base de datos.
(
Colectar toda la información, conocido como "input", que habrá de producir los resultados que el usuario sea ver, hablando con todos los usuarios posibles de base de datos para adquirir ideas adicionales que pueda mejorar el diseño.
(
Dibuje la estructura de la tabla, incluyendo cada campo para el tipo de dato.
	Tabla 1-1: Tipos de Datos Comunes

	TIPO DE DATO
	DESCRIPCIÓN DEL CONTENIDO

	
	

	Text (Texto), predeterminado
	Abarca cualquier tipo de caracteres alfanuméricos (desde 0 hasta 255 caracteres por campo).  Esto incluye letras o números.  Aunque se configure el tamaño de un campo a 255, el programa de Access  solo podrá usar la cantidad de memoria requerida para cada entrada

	
	

	Number (Número)
	Valores numéricos que puede ser empleados para cálculos o comparaciones.  El tamaño y tipo de número que puede ser almacenado dependerá de la configuración actual de la propiedad “Field Size”

	
	

	Date/Time (Fecha/Hora)
	Valores de fecha y hora.

	
	

	Counter (Contador)
	Un valor numérico que aumenta automáticamente

	
	

	Memo
	Caracteres alfanuméricos de longitud infinita.  Es similar al texto pero puede almacenar hasta 64,000 caracteres.

	
	

	


	Microsoft Access y SQL


MS Access proporciona un entorno para integrar Microsoft SQL Server.  Gracias a esto, Access puede aplicarse a una amplia variedad de tareas de desarrollo, desde la aplicación de base de datos personal más pequeña a grandes aplicaciones corporativas para empresas multinacionales.  Entonces, Access permite una alta integración con orígenes de datos empresariales SQL Server, un DBMS para empresas de Microsoft, puesto que Access puede manipular los datos SQL Server en modo nativo directamente a través de la función Proyecto de Access (Access Project).  Las aplicaciones creadas con Access para SQL Server no sufren pérdidas de rendimiento debidas a conversiones de formato.
	La Ventana: “Database” (Base de Datos)


Cuando entramos en Access y especificamos el nombre de la base de datos con la que queremos trabajar, se abre la ventana “Databases” (Base de Datos) que mostramos en la Figura 5.3.

La columna que aparece a la izquierda de la ventana contiene los tipos de objetos de la base de datos, los cuales son:  Tablas (Tables), Consultas (Queries), Formularios (Forms), Informes (Reports), Páginas (Pages), Macros y Módulos (Modules).
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	Figura 5-3: La Ventana de “Database” o Base de Datos.  Esta ventana se emplea para iniciar y crear la estructuración de una base de datos dinámica o relacional.


Por ejemplo, si está seleccionado Tablas, el panel de la derecha muestra los nombres de todas las tblas disponibles en la base de datos actual más tres opciones para crear tablas: la vista de Diseño (Design view), mediante un asistente o mago (using wizard) o simplemente introduciendo datos (entering data).  Igualmente, al seleccionar formularios (Forms), se muestran los nombre de los formularios que se hayan creado y dos opciones para crear formularios: la vista de Diseño (Design view), mediante un asistente o mago (using wizard) o entrando información (entering data) (Véase Figura 5-4).  Access facilita increíblemente la creación de todos los objetos de base de datos qu podamos necesitar para nuestra aplicación.
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	Figura 5-4: La Ventana de “Database” o Base de Dato-Formularios.  Esta de base de datos donde se ha selccionado formularios.


	Crear Tablas


En la Figura 5.6 mostramos un ejemplo de una vista de Diseño después de introducir las especificaciones para el primer campo de una tabla.  Hay que especificar que el nombre del campo, el tipo de datos y un comentario sobre el campo; después se especifican algunas de sus propiedades, como el tamaño del campo, y si el campo está en un índice (indexed).  Una vez hecho esto con todos los campos de la tabla, damos nombre a la tabla y la guardamos.  Esto es todo lo que hay que hacer para crear una tabla de base de datos.  Naturalmente, suponemos que el lector ya ha reflexionado cuidadosamente acerca de qué campos hay que incluir en la tabla, cuáles deben de ser los tipos de datos, qué propiedades deben tener los campos y cómo está relacionada esta tabla con otras tablas de la base de datos.
Después de haber creado las tablas, tenemos formado el esqueleto o estructura de la base de datos.  Todo lo que falta para completar la base de datos es introducir los datos.  Esto lo podemos hacerlo de varias formas: puede ser utilizado un formulario de introducción de datos, escribiendo datos directamente en la tabla o rellenando la tabla automáticamente utilizando un archivo existente.
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	Figura 5-6: La Vista de Diseño (Design View) al Crear una Tabla.  En esta vista se pueden crear campos adicionales, borrar aquellos no necesarios y, muy importante, establecer las propiedades de cada uno de lo campos creados para la tabla.


	Crear Formularios (Forms)


Los formularios de Access son herramientas flexibles.  Los formularios pueden ser de distintos tamaños y pueden contener objetos tales como controles, texto y gráficos.  Si se crean aplicaciones, programando con “Visual Basic Application” (VBA) desde su editor (Visual Basic Editor, VBE), los usuarios ven los formularios e interactúan con ellos.  Al crear formularios podemos:
1.
Introducir datos para una o más tablas de la base de datos.

2.
Modificar los datos existentes en una tabla.

3.
Eliminar datos de las tablas.

4.
Ver los datos de una o más tablas.

En la figura 5-7 mostramos un formulario en blanco
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	Figura 5-7: La Vista de Diseño (Design View) para Crear un Formulario.  En esta vista se pueden crear campos en la forma de controles para luego entrar datos.


	Crear Informes (Reports)


El proceso para crear informes es similar al proceso para crear formularios.  La principal diferencia es que es más probable que los informes sean documentos con varias páginas y, como resultado, estén divididos en secciones, como encabezado y pie del informe, encabezado y pie de página, sección detalle y secciones de grupo.  Los formularios también pueden tener encabezado y pue de formulario y página, pero no es algo frecuente.  En la Figura 5-8 mostramos la vista Diseño (Design view) de un informe en blanco.  Podemos añadir controles y otros objetos desde el cuadro de herramientas a las secciones apropiadas del informe para conseguir el resultado buscado.
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	Figura 5-8: La Vista de Diseño (Design View) para Crear un Informe.  En esta vista se pueden crear controles.


	Crear Páginas de Acceso a Datos


Las páginas de acceso a datos, introducidas en Access 2000, proporcionan un método sencillo para presentar en la Web la información que en una máquina local se encontraría en formularios e informes.  Las páginas de acceso a datos son archivos HTML vinculados con los datos de un origen de datos.  Con las páginas de acceso a datos podemos:
1.
Navegar por los registros del origen de datos.

2.
Añadir, modificar y eliminar datos.

3.
Mostrar los datos clasificándolos o agrupándolos.

Podemos mostrar los datos de la base de datos en la Web de otras formas, pero las páginas de acceso a datos, diseñadas específicamente para la tarea, proporcionan el método más sencillo para poner nuestros datos en línea.
LOS PRIMEROS PASOS PARA TRABAJAR CON ACCESS

Access es parte de un paquete de programas conocido como Microsoft Office, de manera que es comunmente hallado dentro de la carpeta llamada Microsoft Office.  Abajo hay unas instrucciones de cómo correr el programa (también conocido como aplicación) y hacer algunos trabajos iniciales básicos.  Tú necesitas estar familiarizado con estos fundamentaos para poder realizar las actividades en la sección de Aprendizaje de Access.

	Activando el Programa


Existen cuatro maneras para subir el programa, las cuales se describen a continuación:

	(
Tu computadora puede tener atrechos (shortcuts) para los programas en


el escritorio (desktop) de Windows.  De ser así, aplique un doble clic sobre


el atrecho de Microsoft Access para correr elprograma.
	[image: image8.png]Dl




	Atrecho de

Microsoft

Access

	(
O aplique un clic al botón de Start, ubicado en la esquina inferior izquierda

del escritorio de Windows.  Luego, mueva el puntero del ratón hasta la

sección rotulada como “All Programs”; cuando aparezca el menú vertical

a la derecha, mueva una vez más el puntero del ratón hacia la derecha

(dentro dentro de tal menú) hacia el programa de Microsoft Access, sobre el


cual se debe hacer un clic con el botón izquierdo del ratón.
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	Si se posee la versión de Microsoft Access XP (o 2003), se deberá observar un

panel (o menú) en el lado derecho de la ventana inicial del programa.  Bajo la

sección de New, aplique un clic sobre Blank Database.  En en caso de tener

las Versiones 2000 y 97, aplique un clic sobre el botón circular próximo a 

Blank Access database y luego presione con el ratón el botón de OK.
	

	
	

	XP y 2003
	97 y 2000
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Decida cuál será el nombre de tu base de datos y el lugar donde desee guardarlo.  Luego, navegue hacia tal sitio y guarde su archivo.  Es muy importante decidir cuál será el nombre de tu base de datos y dónde se habrá de guardar antes de crear el banco de datos.  Usted puede tener problemas si cambia la ubicación del archivo o modifique el nombre de éste.
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(
O aplique un clic al botón de Start, ubicado en la esquina inferior izquierda del escritorio de Windows.  Luego, mueva el puntero del ratón hasta la sección rotulada como “All Programs”; cuando aparezca el menú vertical a la derecha, mueva una vez más el puntero del ratón hacia la derecha y hacia arriba (dentro dentro de tal menú) hasta llegar a New Office 
Document, sobre elcual se debe hacer un clic con el botón izquierdo del ratón.
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(
A continuación, se observará una ventana titulada“New Office Document”.  Asegúrese que se halla escogido la pestaña (tab) rotulada “General”.  Con  el puntero del ratón, seleccione el icono rotulado Blank Database y luego presione con el ratón el botón de OK.
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Decida el nombre del archivo y dónde se guardará.  Luego, diríjase hacia el lugar donde se desee guardar su base de datos y guárdelo.  Es vital saber cuál será el nombre del archivo y el lugar dónde se habrá de guardar antes de crear el banco de datos.  De lo contrario, se pueden confrontar problemas.
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(
O aplique un clic con el botón derecho de ratón sobre el escritorio de Windows.  A continuación se observará un menú contextual o vertical (popup menu), desde el cual seleccione con el ratón New y luego Microsoft Access Application.
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	Creando una Base de Datos


Una vez guardado el archivo de la base de datos, aparecerá una ventana nueva.  Escoja una de las alternativas de la tal pantalla.
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	Creando un Archivo desde dentro del Programa


Se explicará cómo crear un archivo si usted ya ha comenzado el programa de Access.  Solo es posible tener una base da datos de Access abierta a la vez, de manera que si usted crea una archivo, aquél que está usando será cerrado.

	(
Aplique un clic al icono de New.






o
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	(
Presione las teclas: [Ctrl] [N]
	
	


	Abriendo un Archivo de Access


Existen dos métodos para abrir un archivo de Access.

	(
Aplique un clic al menú de File y seleccione Open.






o
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	(
Presione las teclas: [Ctrl] [O]
	


Nota: Access solamente te permite abrir una base de datos a la vez desde dentro de Access, de manera que si usted abre otro archivo, aqué que usted esta usando será cerrado.

	Guardando un Archivo


Guardando un archivo de Access trabaja como se guarda un archivo en cualquier otro programa de Microsoft Office.

	1.
Aplique un clic al icono de Save 
ubicado 


en la barra de herramientas.






o
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Escoja Save desde el menu de File





o


Presione las teclas: [Ctrl] [S]

2.
Escoja un nombre para tu archivo

3.
Navegue hacia el lugar donde dese guardar el


archivo

4.
Aplique un clic al menú de File y, desde el menú


contextual o vertical, seleccione Save
	

	


	Imprimiendo un Archivo de Access


Los fundamentos para guardar un archivo de Access es muy simple.  Simplemente siga uno de los siguientes métodos:

	(
Aplique un clic al icono de Print ubicado en la barra de herramientas.
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o

(
Escoja Print desde el menu de File

(
Presione las teclas: [Ctrl] [P]
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	Imprimiendo desde Print Preview


1.
Un informe (report) abre en la vista de “Print Preview”.  Aplique un clic a icono de Print localizado 
en la barra de herramientas para imprimir el informe:

2.
Aplique un clic a “Close”para regresar a la vista de la Base de Datos (Database view).
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Help (Ayuda) de Access
Una de las mejores características de Access son sus funciones de ayuda internas.

EJERCICIOS DE PRÁCTICA

	Desarrollo de Una base de Datos para los Estudiantes


	Paso I: Creando una Base de Datos


1.
Desde "Start", seleccione "All Programs", y luego "Microsoft Acccess":
Clic: Start→Seleccionar: All Programs→Microsoft Access
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2.
Se deberá observar un panel (o menú) en el lado derecho de la ventana inicial del programa.  Bajo la

sección de “New”, aplique un clic sobre Blank Database.

Panel Derecho, bajo: New→Seleccionar: Blank Database
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NOTA:  Para las versiones de Microsoft 97 y 2000, habrá de aparecer una caja de diálogo (tipo de ventana) titulada "Create a New Database Using".  Seleccione el botón circular titulado "Blank Database" y luego aplique un clic sobre el botón de "OK".
3.
Ahora debe aparecer la ventana titulada: "File New Database".  Asegúrese que se encuentre conectado su “Flash Drive” al puerto USB de la máquina.  En la sección superior de esta ventana, rotulada como "Save in", aplique un clic dentro de su caja de diálogo y escoja la letra de su “Flash Drive”, diríjase hacia a la carpeta de su portafolio digital, luego a MS Office y finalmente abra la carpeta de MS Access.  Abajo, rotulado como "File name", seleccione la caja que tiene escrito db1.  Borre o sombree ("drag") este nombre y en su lugar escriba: Rec_Estudiantes.  Ahora, aplica un clic sobre le botón de "create":
Ventana de: File New Database→Bajo: Save in→Buscar lugar donde se guardará→ Bajo: File name→Escribir: Rec_Estudiantes→Clic: Create
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En estos momento debe aparecer la ventana de la Base de Datos titulada con el nombre del archivo previamente escrito: "Rec_Estudiante: Database".  Esta tabla se compone de varias "pestañas" (tabs) de los Objetos .
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	Paso II: Creando una Tabla


1.
Debes estar en la ventana de Database titulada "Rec_Estudiante: Database".  De forma predeterminada, se ha seleccionado el menú de “Tables” (en MS Access 97 se refiere a la pestaña, o “tab”, rotulada como "Tables").  Desde aquí vamos a crear la tabla usando el mago (wizard).  Aplique un doble clic sobre “Create table by using Wizard”.

Desde Ventana: Rec_Estudiante: Database→Bajo menú de: Tables→Doble Clic sobre: Create table by using Wizard
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NOTA:  En la versión 97, desde la pestaña de "Tables", se aplica un clic sobre el botón de "New".  Automáticamente debe de aparecer la ventana titulada: "New Table".  Seleccione "Table Wizard" desde la caja de diálogo, luego aplique un clic al botón de "OK".
	Paso III: El “Table Wizard”


1.
Estamos ahora en la ventana titulada: "Table Wizard".  Desde aquí se habrá de crear la tabla, con sus respectivos campos.  Debe estar seleccionado el círculo rotulado como "Business".  Aplique un clic sobre la flecha hacia abajo de la caja de diálogo rotulada con el nombre de "Sample Tables" Despliegue hacia abajo de la lista hasta llegar al reglón de "Students", el cual está localizado en la posición penúltima de la lista.  Aplique un clic sobre este reglón de "Students".
Desde Ventana: Table Wizard→Seleccionar: Business→Bajo: Sample Tables→Escoger: Students
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2.
Ahora se habrán de seleccionar los campos que deberán constituir la tabla.  En nuestro caso, se requieren crear 24 campos.  Primero debemos pasar los 14 campos predeterminados que nos ofrece  la tabla de “Students”, los cuales se puede observar bajo la sección de “Sample Fields”, que son: StudentID, First Name, Middle Name, Last Name, Parents Names, Address, City, StarOrProvince, Postal Code, Phone Number, Email Name. Mayor, Student Number y Notes.  Para poder transferirlos simultáneamente hacia la caja de diálogo rotulada como: "Fields in my new Table", desde el renglón de “Sample Fields”, escoja el primer campo (StudentID) y luego presiona el botón [image: image33.bmp]:
Desde: Sample Fields→Seleccionar: StudentID→Clic Botón: [image: image34.bmp]
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Ahora debemos añadir diez (10) campos, de manera que se completen los 24 que necesitamos.  Para esto, simplemente se debe escoger un campo a la vez (hasta seis) desde la caja de diálogo rotulada como "Sample Field" y luego aplicar un clic al botón de [image: image37.bmp] (o aplique un clic doble rápido sobre el campo) para poder añadirlo a la próxima caja de diálogo titulada como "Fields in my new Table".  Continúe este procedimiento hasta que complete los 24 campos:
Desde Sección: Sample Fields→ Seleccionar Campo: StudentID →Clic Botón: [image: image38.png]


→Repetir Procedimiento hasta Añadir 8 Campos a la Sección: Fields in my new Table
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3.
El próximo paso es cambiar el nombre original de los campos.  Aplique un clic sobre el botón de "Rename Field" para cambiar los nombres de los campos al español y añadir otros.  A continuación se observará una pequeña ventana, o caja de diálogo, titulada “Rename Field”, desde donde se habrán de cambiar los nombres.  Para colocar el nuevo nombre, simplemente aplique un clic sobre la cajita rectangular que tiene el nombre del campo original (Ej: StudentID), escriba el nuevo texto en tal caja de diálogo (Ej: IDestudiante) y luego haga clic sobre le botón de “OK”:
Desde: Rename Field→Clic sobre caja rectangular: StudentID→Escriba Nuevo Campo: IDestudiante→Clic: OK
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Los nombres de los campos nuevos deben de leer como sigue:
	IDestudiante

Apellidos
Nombre

Inicial

SS

NombreEncargado


	FechaNacimiento

Edad

Género

Dirección

Pueblo

País


	CódigoPostal

Teléfono

Email

Concentración

MaestroSH

CursosSemI07


	CursosTomados

AyudaEcom

Créditos

PromGen

PromConc

Necesidades




4.
Si tiene más de 24 campos, puede eliminar los campos adicionales al aplicar un clic sobre el botón [image: image44.bmp].  Por ejemplo, seleccione el campo (Ej: StudentID2) dentro de la sección “Fields in my new Table”:
Si tiene más de 24 campos, Desde: Fields in my new Table→Seleccione Campo: StudentID2→Clic [image: image45.png]



	[image: image46.png]Table Wizard

Vibich of the sample tables Isted below do you want to use to create your table?

After selecting 2 table category, choos the sample table and sample fieds you want o inciude
in your new table. Your table can incude fieds from mre than one sample table. If you're not
sure about a field, go ahead and indude I, Its easy to delete a fild later.

 busness Sampl el Fedsinmy new tabie:
 persona ~ e

E ersiiane BN ity
Sample obles: vicdeame — 5| |wedeniamer E]

e 2 e

Service Records Parentshames < Parentshames1
;’3::3‘“""5 Address |Address1

= aty
EncloycesindTasks StateOrProvince <[ fercmome

| [postaicoce

Students And Classes || poremvemor ] ename Feld

Cancel Next > Erish





	[image: image47.png]Table Wizard
Vibich of the sample tables lsted below do you want to use to create your table?

After selecting 2 table category, choos the sample table and sample fieds you want o inciude
in your new table. Your table can incude fieds from mre than one sample table. If you're not
sure about a field, go ahead and indude I, Its easy to delete a fild later.

= e iy e ol
P a DT
E ersiiane BN ity

MiddeName 1 8
Lasthame1
Parentsiames1
adress1

Sampe Tales: iderans 8=
sstine |

aenishanes

dvess .k

City <<

Sitzorpronce

rostaicoce

[t

Service Records
Transactons
Tasks
EmployessandTasks

k3

Miditiome

[l

Students And Classes

3

Rename Fild

Cancel Next > Erish







5.
Cuando termines de entrar y renombrar los 22 campos arriba enumerados, aplique un clic sobre el botón de “Next”:
Al terminar→Clic: [image: image48.png]Next >
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6.
Debes ahora de otorgarle un nombre a la Tabla.  Bajo la caja de diálogo rotulada como "What do you want to name the table?".  Sustituya el nombre predeterminado de "Students" por el de "Estudiantes".  Debes de asegurarte que se encuentre seleccionado el círculo rotulado como "No, I’ll set the primary key".  La clave primaria (primary key) será determinada en la prónxima ventana del Mago o desde en la Vista de Diseño (Design View).  Aplique un clic sobre el botón de "Next" para aceptar estas alternativas.

Desde: What do you want to name the table?→Clic sobre caja rectangular: Students→Escriba Nuevo Nombre: Estudiantes→Clic Botón Cicular: No, I’ll set the primary key →Clic: [image: image50.png]Next >
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7.
En esta próxima caja de diálogo del Mago, bajo “What field will hold data that is unique for each record?”debes ahora decidir cuál será el campo que tendrá la clave primaria (primary key).  Deja el que tiene, es decir, el campo rotulado como IDestudiante.  Debes de asegurarte que se encuentre seleccionado el círculo rotulado como "Numbers and/or letters I enter when I add new records".  Aplique un clic sobre el botón de "Next" para aceptar estas alternativas.

Desde: What field will hold data that is unique for each record?→Clic Botón Cicular: Numbers and/or letters I enter when I add new records→Clic: [image: image53.png]Next >
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8.
Ahora debe de verse la tercera caja de diálogo del "Table Wizard".  Seleccione la alternativa de "Modify the table design".  Luego aplique un clic sobre el botón de "Finish":

Desde: Tercer Ventana del Wizard→Clic: Modify the table design→Clic: [image: image56.png]Enish
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	Paso IV: Modifique la Tabla


1.
Estamos ahora en la Vista de Diseño (Design View).  Verifique que la columna de los nombre de los campos ("Field Name") posea todos los campos previamente mencionados.  Si le falta alguno, se deberá en estos momentos añadir.  Si fue el último campo que no se añadió, aplique un clic en la última celda vacía de esta columna y escriba el nombre del campo omitido.  Por ejemplo, si el último campo omitido fue Necesidades, mueva el puntero del ratón hasta la última celda vacía, debajo del campo PromConc y escriba Necesidades.  En el caso que el campo omitido fue más arriba de la columna, es decir, en medio de otros, aplique un clic donde debería estar este campo, seleccione "Insert", desde el menú de barra y luego "rows"; este procedimiento abrirá una fila donde se escribirá el nombre del campo a ser añadido  Esto mismo se puede hacer si se aplica un clic con el botón derecho del ratón; en este caso, se observará un menú contextual o vertical, desde el cual se deberá seleccionar “Insert Rows”.  Ahora escriba el nombre del campo omitido.  Para exponer un ejemplo, si el campo omitido fue el de País (debe ir debajo de Pueblo y arriba de Código Postal), entonces ubique el puntero del ratón dentro del campo de Código Postal, diríjase hacia el menú de barra de Access, aplique clic sobre “Insert” y, dentro del menú contextual, escoja “Rows”.  A continuación se abrirá una nueva fila, en la cual deberá escribir País:
Vista de Diseño (Design View):
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Para Añadir Campos→Clic: Última Celda Vacía→Escriba el Nombre del Campo Omitido
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Para Añadir Campos: En Medio de Otros→Clic: Campo Requerido→Desde: Menú de Barra→Insert→Rows→Nueva Fila→Escriba el Nombre del Campo Omitido
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Para Añadir Campos con el Botón Derecho del Ratón: En Medio de Otros→Clic: Campo Requerido→Clic: Botón Derecho del Ratón→Insert Rows→Nueva Fila→Escriba el Nombre del Campo Omitido
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2.
Desde esta ventana, es posible cambiar la clave primaria (Primary Key).  Por ejemplo, si prefiere que clave primaria sea el seguro social del estudiante (SS), solo tiene que aplicar un clic con el botón derecho del ratón sobre este campo y, desde el menú contextual, seleccionar Primary Key.  Automáticamente el seguro social pasará a ser la nuava clave primaria.
Para Cambiar Clave Primaria, Clic: Campo SS→Clic: Botón Derecho del Ratón→Primary Key
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3.
Modifique la columna de "Data Type".  Para este procedimiento, aplique un clic en la celda que requiere ser editada.  Automáticamente habrá de aparecer una flecha hacia abajo con un menú vertical (o contextual).  A continuación, seleccione el tipo de dato que se requiera.  Asegurase que los cambios realizados bajo esta columna posea la siguiente información:
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Desde Columna: Data Type→ Clic Celda para Modificar: IDestudiantes→Clic:[image: image73.bmp]→Desde Menú Contextual→Seleccionar: Tipo de Dato Requerido: Memo
La razón de seleccionar el tipo de dato Memo, es que el número de identificación (IDestudiante) del estudiante incluye también letras.  Memo, pues, apoya texto y números (alfanumérico).
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Desde Columna: Data Type→ Clic Celda para Modificar: Apellidos→Clic:[image: image77.bmp]→Desde Menú Contextual→Seleccionar: Tipo de Dato Requerido: Text
	[image: image78.png]Feld Name_ Data Type
Testudiante emo.

Apelidos Number ~
Tricial Number





	[image: image79.png]Data Type
Wema

i —




	[image: image80.png]Field Name Data Type

TDestudante Wemo
apelidos. Text







Continúe modificando los tipos de datos que sean requeridos.  Bajo las Propiedades del Campo, es importante que los tipos de datos que sean de texto, se debe reducir el tamaño de sus caracteres (Field Size).  Para los tipos de datos numéricos, borre el cero (0) que se encuentre bajo “Default Value”.  Esto será discutido en los próximos pasos.
4.
Guarde la tabla.  Diríjase al menú de barra, haga clic sobre “File” y, desde el menú contextual,  seleccione "Save".
Desde: Menú de Barra→Clic: File→Seleccione: Save
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	Paso V: Modificar las Propiedades de cada Campo


Para cada campo creado modifique sus propiedades desde la sección de “Field Properties”.  Esto incluye el tamaño de su campo (File Size), el formato o “Format”, su “Input Mask”, el rótulo o “Caption” del campo,el valor predeterminado (Default Value) de los datos numéricos, la validación de su valor (Validation Rule), si es requerido (Required), si va a ser indexado (Indexed) y los espacios decimales que requieren los datos numéricos (Decimal Places).  Algunos ejemplos se muestran a continuación
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	Campo: Género
	Campo: SS
	Campo: PromGen


Añadir un “Input Mask”
1.
Un “Input Mask ” facilita la entrada de los datos en un campo y sirve de filtro para controlar el tipo de dato entrado en éstos.  Para poder emplear la utilidad de “Input Mask”, el Tipo de Dato (“Data Type”) del campo debe estar configurado como “Text”.  Desde la columna de “Field Name”, haga un clic en la celda del campo para el SS.  Ahora, mueva el puntero del ratón, hacia la región inferior izquierda de la tabla, conocida como las Propiedades del Campo (“Field Properties”).  Asegurándose que se encuentre seleccionada la pestaña de “General”, aplique un clic en el encasillado rectangular próximo al “Input Mask”.  En el extremo derecho de este encasillado, se deberá observar la Caja de Construcción o “Build box” ([image: image86.bmp]), la cual contiene tres puntos.  Ejecute un clic a tal caja de los tres puntos suspensivos.  Si no se posee esta opción de Access, aparecerá un alerta de Windows, indicando que lo instale; escoja “Yes” de no poseer esta función y siga las instrucciones.  Finalizada la instalación, aplique de nuevo un clic a los tres puntos suspensivos ([image: image87.bmp]).  En estos momentos, deberá observarse una nueva ventada titulada: “Input Mask Wizard”; seleccione del listado: "Social Security Number".  Para comprobar cómo funciona, haga un clic al lado izquierdo del encasillado “Try It” y escriba el siguiente número de seguro social: 578-97-7685.  Luego de escribir los primeros tres dígitos, el cursor brinca fuera de su sección de tres caracteres hacia la próxima de dos, y luego que termine de escribir estos dos números, te salta hacia los últimos tres dígitos.  Este proceso acelera la entrada de los números del seguro social.  Para terminar, aplique un clic el botón de “Finish”.  Se forman caracteres adicionales que Access incluye, pues su uso aparece en la caja de “Input Mask”.  Repita este procedimiento con el campo de FechaNacimiento.  En este caso, desde su “Input mask”, selecione “short date”.  Haga lo mismo con el campo de CódigoPostal y escoja “Zip Code” en el mago (“Wizard) del “Input Mask”
Finalmente, con el campo de Teléfono repite este procedimiento, seleccionando “Phone Number” del listado en el “Input Mask”.
Desde: Columna Field Name→Clic Celda: SS→Seleccione Pestaña: General→Clic Encasillado: Input Mask→Clic: [image: image88.bmp]→ Instale esta Función de Ser Necesario→Escoja: Social Security Number→Clic: [image: image89.png]
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Repita el Input Mask con la fecha de nacimiento, código postal y el teléfono.

Realizar Otros Cambios desde “Field Properties”
1.
Desde la Vista de Diseño (Design View), escoja el campo de la columna para los Apellidos.  Ahora, diríjase hacia las Propiedades del Campo (“Field Properties”), o la región inferior izquierda de la tabla, asegurándose que se encuentre seleccionada la pestaña de “General”.  Aplique un clic en el encasillado rectangular que corresponde a “Field Size” y cámbielo a 25.  Ahora aplique un clic a la caja rotulada como “Required”, haga clic a la flechita hacia abajo ([image: image100.bmp]) ubicada en el extremo derecho de este encasillado y seleccione "Yes" del menú vertical/contextual.

Desde: Design View→Desde Tabla: Estudiantes→Desde Columna: Field Name→Clic Celda del Campo: Apellidos→Desde: Propiedades del Campo→Seleccione Encasillado: Field Size→Escriba: 25→Seleccione Encasillado: Required→ Clic Flechita: [image: image101.bmp]→ Seleccione: Yes
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2.
Selecione el campo de País y, desde las Propiedades del Campo (“Field Properties”), haga un clic al encasillado rotulado como "Field Size" y escriba 2.  Verifique que el en encasillado de "Default value" no haya ningún valor, de lo contrario, bórrelo.
Desde: Design View→Desde Tabla: Estudiantes→Desde Columna: Field Name→Clic Celda del Campo: País→Desde: Propiedades del Campo→Seleccione Encasillado: Field Size→Escriba: 2→Encasillado: Default value→Debe estar vacío
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Añadir un “Validation Rule”
1.
Desde la columna de ”Field Name”, seleccione el campo llamado Género.  Mueva el puntero del ratón hacia las Propiedades del Campo (“Field Properties”), ubicada en la región inferior izquierda de la tabla.  Seleccionada la pestaña de “General”, haga un clic en el encasillado rectangular que corresponde a “Field Size” y sustituya su tamaño original por 1.  Aplique un clic sobre la caja rotulada como “Format” y escriba el signo > para convertir el dato en mayúscula.

Desde: Design View→Desde Tabla: Estudiantes→Desde Columna: Field Name→Clic Celda del Campo: Género→Desde: Propiedades del Campo→Seleccione Encasillado: Field Size→Escriba: 1→Escoja Encasillado: Format→Escriba: >
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2.
Aún estando en las propiedades del campo Género, aplique un clic en la caja de “Validation Rule” y escriba ="M" or "F", de modo que solo se acepten estos dos valores durante la entrada de datos.  Ahora, haga un clic en la caja de “Validation Text” y escriba Tú debes especificar M ó F.  
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Otros Cambios en las Propiedades del Campo

1.
Escoja el campo de las Iniciales, luego al “File Size” y cambiar a 1.  Ir al campo de Nombre y en su propiedad del Tamaño cambiar a 15.  Reducir el tamaño del campo de Pueblo a 15.  En la propiedad de “Caption”del campo Email escribir Correo Electrónico.  Para el campo rotulado como Concentración escribir 20 bajo su propiedad de “Field Size”.  Los campos PromGen y PromConc deben de poseer 2 espacio decimales, lo cual debe especificarse bajo la propiedad del campo “Decimal Places”.  Para esto mismos campos, especificar en su propiedad de “Caption” Promedio General y Promedio de Concentración, respectivamente.

2.
Guarde la tabla.  Aplique un clic al icono de Save ([image: image112.bmp]) ubicado en la barra de herramientas.  Otro método para salvar la tabla es seleccionando Save desde el menu de File, es decir, desde el menú de barra, aplique un clic al menú de File y en el menú vertical o contextual, seleccione Save  Una alternativa más rápida para archivar la tabla es usando el atrecho de teclado: [Ctrl] [S]

Desde: Menú de Barra→Clic File→Seleccione: Save
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	Paso VI:  Entrar Los Datos – Desde la Vista de la Tabla (Datasheet View)


1.
Diríjase a la barra de menú, dé un clic sobre el menú de “View” y seleccione “Datasheet View”.
Desde Menú de Barra: View→Datasheet View
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2.
Entre los siguientes datos para cada campo de la tabla:
CASO I:
	IDestudiante
	M0004528
	CódigoPostal
	00986 8271

	Apellidos
	Tirado Rosario
	Teléfono
	787 764 2789

	Nombre
	Juan
	Email
	tira22@hotmail.com

	Iniciales
	A
	Concentración
	Educación

	SS
	577 99 2119
	CursosSemI07
	CIENC 101, ING 101

	NombreEncargado
	Tirado Marin, José
	CursosTomados
	BIOL 101, ESP 101

	FechaNacimiento
	02 02 1990
	MaestroSH
	Raspequi, Cátala

	Edad
	17
	AyudaEcom
	Sí

	Género
	M
	Créditos
	76

	Dirección
	Vía 16, JR-2, Villa Fontana
	PromGen
	2.95

	Pueblo
	Carolina
	PromConc
	3.77

	País
	PR
	Necesidades
	Pupitre grande


CASO II:

	IDestudiante
	M0007689
	CódigoPostal
	00986 8271

	Apellidos
	Torres Toledo
	Teléfono
	787 764 2789

	Inicial
	V
	Email
	Tole88@yahoo.com

	Nombre
	Tomás
	Concentración
	Educación Física

	NombreEncargado
	Torres Hernández, Rigoberto
	MaestroSH
	Torrens, Mario

	SS
	581 08 6653
	CursosSemI07
	MATE 101, HIST 101

	FechaNacimiento
	02 04 88
	CursosTomados
	MUS 101, EDFI 101

	Edad
	19
	AyudaEcom
	Sí

	Género
	M
	Créditos
	118

	Dirección
	Calle Pitirre, Barrio Corea
	PromGen
	2.77

	Pueblo
	Guaynabo
	PromConc
	2.79

	País
	PR
	Necesidades
	Estar cerca de pizarra


CASO III:

	IDestudiante
	M0004318
	CódigoPostal
	00986 8071

	Apellidos
	Abreu Morales
	Teléfono
	787 768 2629

	Nombre
	Carla
	Email
	abreum@lycos.com

	Inicial
	C
	Concentración
	Educación

	NombreEncargado
	Abreu Melendez, Asunción
	MaestroSH
	Cardona, Rigoberto

	SS
	588 13 9787
	CursosSemI07
	HUM 101, TEC 101

	FechaNacimiento
	05 01 86
	CursosTomados
	ING 101, ESP 101

	Edad
	22
	AyudaEcom
	Sí

	Género
	F
	Créditos
	86

	Dirección
	Calle 12, 921 SE
	PromGen
	2.77

	Pueblo
	Carolina
	PromConc
	2.97

	País
	PR
	Necesidades
	Ninguna


CASO IV:

	IDestudiante
	M0001155
	CódigoPostal
	00936 7181

	Apellidos
	López Calero
	Teléfono
	787 786 4057

	Inicial
	M
	Email
	ccalero@gmail.com

	Nombre
	Cinthia
	Concentración
	Justicia Criminal

	NombreEncargado
	López Marrero, Mateo
	MaestroSH
	Porrata, Karla

	SS
	507 09 1244
	CursosSemI07
	EDFI 101, ART 101

	FechaNacimiento
	11 27 88
	CursosTomados
	MAT 101, QUIM 101

	Edad
	19
	AyudaEcom
	Nó

	Género
	F
	Créditos
	55

	Dirección
	Calle Pitirre, RG 86
	PromGen
	3.77

	Pueblo
	San Juan
	PromConc
	3.84

	País
	PR
	Necesidades
	Estar cerca de pizarra


CASO V:

	IDestudiante
	M0003788
	CódigoPostal
	00956 7791

	Apellidos
	Salaberry Porras
	Teléfono
	787 790 8677

	Inicial
	M
	Email
	nm@universia.com

	Nombre
	Nichol
	Concentración
	Música Popular

	NombreEncargado
	Salaberry Soriano, Federico
	MaestroSH
	Porrata, Karla

	SS
	590 20 8451
	CursosSemI07
	ART 101, MUS 101

	FechaNacimiento
	08 09 89
	CursosTomados
	EDFI 101, HIST 101

	Edad
	18
	AyudaEcom
	Sí

	Género
	F
	Créditos
	24

	Dirección
	Carr 186, km 7, Barrio Piña
	PromGen
	3.95

	Pueblo
	Orocovis
	PromConc
	3.97

	País
	PR
	Necesidades
	Ninguna


3.
Guarde la tabla.  Diríjase al menú de barra, haga clic sobre “File” y, desde el menú contextual, seleccione "Save".

Desde: Menú de Barra→Clic: File→Seleccione: Save
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4.
Cuando termines, seleccione el menú de “File””y aplique un clic sobre “Close”.  Luego, escoja “Exit”.

Desde: Menú de Barra→Clic: File→Seleccione: Exit
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	Crear un Formulario (Form) para la Entrada de Datos en Rec_Estudiantes


	Paso I: Abrir las Base de Datos: Rec_Estudiantes


1.
Para abrir la base de datos existente, aplique un clic al menú de File y seleccione Open.
Desde: Menú de Barra→Clic: File→Seleccione: Open
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2.
Ahora de debe estar en la ventana de”Database” (Rec_Estudiantes). Asegúrese que se encuentre seleccionado a tabla rotulada como Estudiantes.  Desde el menú a la izquierda de tal ventana, dé un clic a "Forms" 
Desde: Ventana de:→Database→Seleccionado: Estudiantes→Seleccione: Forms
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3.
A continuación, haga un clic a “Create form by using wizard”
Desde: Ventana de Database→Clic: Create form by using wizard
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	El “Form Wizard”


1.
Debes de observar la caja de diálogo titulada: "Form Wizard", la cual corresponde a la tabla de la base de datos que hemos nombrado como "Estudiantes".  En esta primera página del “Form Wizard”, se pueden observar todos los campos que posea la tabla de estudiantes.  Haga un clic al botón rotulado [image: image126.bmp] para entrar todos los campos de la tabla en la forma.  Ahora aplique un clic sobre el botón de "Next".

Desde Ventana: Form Wizard→Clic Botón: [image: image127.bmp]→ Aplicar clic sobre:[image: image128.png]Next >
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2.
En la segunda página del “Form Wizard”, seleccione el tipo despliegue (layout) de la forma.  Si deseas, puedes previsualizar en esta ventana cada uno de los tipos de despliegues.  El despliegie columnar es el más común y comúnmente de permite visualizar un registro completo a la vez desde la vista de la Forma (Form view).  El despliegue Tabular te permite ver varios registros a la vez desde la vista de la Forma (Form view), mientras que el despliegue de Datasheet genera una forma que solo puede observarse desde la vista de la hoja de datos (Datasheet view).  Es nuestro caso, haga sobre el botón circular próximo a “Columnar”.  Aplique un clic al botón de "Next".

Desde la Segunda Ventana de: Form Wizard→Seleccionar: Columnar→Clic botón:[image: image131.png]Next >
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3.
La tercera página del “Form Wizard” se emplea para determinar el estílo de la forma, lo cual afecta el color o patrón de fondo, las fuentes (fonts), el diseño de los controles y otras características.  Una vez más, es posible previsualizar cada opción.  Desde la caja que muestra el listado de alternativas, selecione "Standard" como el estilo para tu forma.  A continuación, dé un clic al botón de "Next".

Desde la Tercera Ventana de: Form Wizard→Seleccionar: Standard→Clic botón:[image: image134.png]Next >




 

	[image: image135.png]what style would you ke?

Blends
Blueprint
Expedtion
Industral
International
Ricepaper
Sandstone
Stane.

S Painting

T T





	[image: image136.png]what style would you ke?

Blends
Blueprint
Expedtion
Industral
International
Ricepaper
Sandstone

Stane.
S Painting

T R RO B







4.
Finalmente, la cuarta o última página del "Form Wizard" se emplea para asignarle un nombre a la forma y determinar la manera en que ésta se abrirá inicialmente.  Si te decides por la primera opción (Open the form to view or enter information), la forma se abrirá desde la vista de la Forma o Form view (o desde la vista de la hoja de datos o Datasheet view, si seleccionaste el despliegue de Datasheet), de manera que podrás inmediátamente utilizar la forma para ver o modificat los datos.  Por el otro lado, si escoges la segunda alternativa (Modify the form’s design), la forma se abrirá en las vista de diseño (Design View), lo cual te permite alterar su diseño.  En la pregunta por el título de la forma (What title do you whant for your form?) deje el nombre que ya tiene: “Estudiantes”.  Mantenga la entra de de esta entrada Modify the form’s design.  Aplique un clic al botón de “Finish”.
Desde la Cuarta Ventana de: Form Wizard→Escribir: →Estudiantes→Seleccionar: Modify the form’s design → Clic: [image: image137.png]
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	Modificar los Controles (Formatear el Formulario)


Antes de nada, guarde el formulario.  A continuación se deberá ver la ventana del formulario editable.
“Vista del Diseño”del Formulario (Form‘s Design View):
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1.
De ser necesario, haga un clic al "botón de Maximizar" ([image: image141.bmp]), de manera que el formulario abarque toda la pantalla.  El "Form Wizard" había ordenado los controles en un formato columnar, pero usted necesita reordenar los controles.

Desde: Form‘s Design View→Clic: Botón de Maximizar ([image: image142.bmp])
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2.
Ajuste el tamaño de la caja de texto que corresponde al control rorulado “IDestudiantes”.  Aplique un clic sobre tal caja, de manera que exhiba las manecillas de ajustar el tamaño.  Debes de asegurarte de seleccionar la caja de texto y no el rótulo adscrito.  Haga un clic sobre el borde central inferior de la caja y arrástrela hacia arriba  (el puntero cambiará a una doble flecha), de forma que se reduzca el ancho de la caja, a nivel de la misma línea de su rótulo correspondiente.  Utilice la rejilla para ajustar el espacio y alinear los controles.
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3.
Suba el control de Apellidos hasta el nivel del control de “Pueblo”.  Aplique un clic sobre el control rotulado como "Apellidos", de manera que exhiba las manecillas de ajustar el tamaño.  Debes de asegurarte que el puntero del ratón cambie a una manita negra.  Manteniendo presionado el botón izquierdo del ratón, arrastre este control hasta que se encuentre en la misma línea del control de "Pueblo".y debajo de “IDestudiantes”.  Utilice la rejilla para ajustar el espacio y alinear los controles.
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4.
Continue arreglando los demás controles en este formulario.  Cuando termine, guardeo los cambos y cierre la ventada
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	Entrar los Datos que Faltan desde el Formulario


1.
Termine de entrar los datos de los estudiantes que faltan.  Primeramente, desde la ventana de”Database” (Rec_Estudiantes), asegúrese que se encuentre seleccionado a tabla rotulada como Estudiantes y "Forms"’(menú de la izquierda).  Ahora, aplique un doble clic sobre Estudiantes.
Desde: Ventana de:→Database→Seleccionado: Estudiantes→Seleccionado: Forms→Doble Clic: Estudiantes
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2.
Debe ahora verse el formulario para la entrada de loas datos, mostrando la información del primer registro.  Pase al próximo registro y entre los restantes cuatro estudiantes.
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	Creando y Usando Formularios Interactivos


	Paso I: Abrir la Base de Datos Rec_Estudiantes


1.
Desde "Start", seleccione "All Programs", y luego "Microsoft Acccess":

Clic: Start→Seleccionar: All Programs→Microsoft Access
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2.
Diríjase al menú de barra, haga clic sobre “File” y, desde el menú contextual, seleccione "Open".
Desde: Menú de Barra→Clic: File→Seleccione: Open
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3.
En estos momentos deberá observarse la caja de diálogo de “Open”.  Desde la sección rotulada “Look in:”, haga clic a la flechita hacia abajo ([image: image158.bmp]), busque en el menú contextual la letra de su “Flash Drive” y luego la carpeta de “MS_Access”.  Seleccione el archivo “Rec_Estudiantes” y luego haga clic sobre el botón de “Open”.Título
Desde Caja de Diálogo: [image: image159.bmp]→Clic Menú Contextual de: [image: image160.png]


→Seleccione Letra y Carpeta de MS Access→Seleccione: [image: image161.png]IRec_Estudiantes.mdb



→Clic: [image: image162.png]
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	Paso II: Crear una Nueva Tabla


1.
Debes estar en la ventana de Base de Datos (Database) titulada "Rec_Estudiante: Database".  Desde el menú del panel izquierdo, rotulado como “Objects”, haga clic sobre “Tables”.  Desde aquí vamos a crear la tabla usando la vista de Diseño (Design View).  Aplique un doble clic sobre “Create table in Design view”.

Desde Ventana: Rec_Estudiante: Database→Bajo menú de: Tables→Doble Clic sobre: Create table in Design view
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	Paso III: Crear Campos desde la Vista de Diseño (Design View) de la Tabla


1.
Desde esta vista, entre los siguientes datos:
	Field Name
	Data Type
	Description

	IdMaestro
	Memo
	Número de identificación del maestro

	Apellidos
	Text
	Apellidos paterno y materno del maestro

	Nombre
	Text
	Nombre del maestro

	Inicial
	Text
	Inicial o iniciales

	Dirección
	Text
	Dirección física del maestro

	Ciudad
	Text
	Ciudad donde vive

	Pais
	Text
	El país o nación en que vive el maestro

	CodigoPostal
	Text
	El “zip code” de maestro

	Preparacion
	Text
	La concentración o especialidad del maestro

	SalonHogar
	Text
	La clase salón hogar del maestro

	CursosSem107
	Text
	Los cursos que ofrece el maestro durante el SEM 1, 2007

	CursosOnline
	Text
	Cursos en línea o a distancia que ofrece

	ConsejeriaAcad
	Text
	Si ofrece consejería académica

	EstAsignados
	Text
	Los estudiantes asignados  para consejería académica

	SitoWeb
	Hyperlink
	La dirección del Web que posee el profesor para sus cursos.


Desde: Design View→Entrar Datos en: Field Name→Modificar: Data Type→Escribir su Descripción bajo: Description
2.
Para cada campo creado modifique sus propiedades desde la sección de “Field Properties”.  Esto incluye el tamaño de su campo (File Size), su “Input Mask”, el rótulo o “Caption” del campo, los espacios decimales que requieren los datos numéricos (Decimal Places), si es requerido (Required), si va a ser indexado (Indexed) y el valor predeterminado (Default Value) de los datos numércos.
3.
Guarde la tabla.  Diríjase al menú de barra, haga clic sobre “File” y, desde el menú contextual, seleccione "Save As".  Desde la caja de diálogo de “Save As”, bajo la sección de “Save Table ‘Table 1’ To”, escriba Maestros y luego haga clic sobre el botón de OK.
Desde: Menú de Barra→Clic: File→Seleccione: Save As→Desde: Caja de Diálogo: Save As→Bajo: Save Table ‘Table 1’ To→Escriba: Maestros→Clic: [image: image167.png]
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